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1. Introduction

This manual is for users who are interested in using LTspice to simulate digital circuit. It focuses on DC
and transient simulations. The manual describes how to find the delay, rise time and fall time in both
methods — capture from waveform viewer and using MEASURE command. Power consumption simulation,
static and dynamic power consumption, is stated as well.

The sample circuit used in the manual is an inverter. However, the methods presented in the manual
can be applied to other digital circuit simulations.

1.1 Installation

You need to install LTspice and technology library to proceed. Follow the steps listed below to finish
the installation.

A. Download LTspice from http://www.linear.com/designtools/software/ .

B. Install LTspice following the prompts.

C. Putthe CMOS_018.lib in C:\Program Files\LTC\LTspicelV\lib\sub which is the default installation
path (check yours if you didn’t use the default installation path).

D. Put nmos_018.asy and pmos_018.asy in C:\Program Files\LTC\LTspicelV\lib\sym which is the
default installation path (check yours if you didn’t use the default installation path).

Both the LTspice and technology library have been installed if you have finished the steps above.

1.2 Schematic window

Schematic window is the window where you create schematic, specify simulation, edit command, and
run simulation.

To open a schematic window, double click LTSpicelV icon on the desktop (LTspice starts as Figure 1),

P
and then click on the LTspice window , an empty schematic window appears as Figure 2, where Draftl
is the default schematic name and .asc is LTspice extension of schematic.
o L Tspice IV - U I

Eile View Tools Help

| P& H|RFOOQOQAQAR|BEERE| s LBAAB| LD L3 YD OO Oy

Ready
Figure 1. LTspice window

- ________________________________________________________________________________________________|
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i LTspice IV - [Draft1.asc] -8

4. File Edit Hierarchy View Simulate Tools Window Help

B d T F0aaar Erw t288 A8 L0 3 xD000 An op

Figure 2. Schematic window

Moving mouse over the icon bar or click the menu on the tool bar, to see what functions they can
perform.

1.3 Waveform viewer

The waveform viewer is the window where you can explore simulation results.

After each simulation, a waveform viewer (window) will automatically pop up with its name same as
the schematic’s name, as shown in Figure 3.

i LTspice IV - test inverter.asc - O
File Edit Hierarchy View Simulste Tools Window Help

Z 0" Rl 4 QoarR|E HEaE i i o8 Ly +x3xD00 A op

4, Draftlasc| 1. testnveterasc § test inveterraw
r

2 test_inverterraw =

Figure 3. Waveform window

To plot the signals after simulation, do as follows:

e Left click on any wire to plot the voltage on the waveform viewer

rd

Voltage probe cursor

e Left click on the body of the component to plot the current on the waveform viewer

i

Current probe cursor

Alternately, you can right click on the waveform window, and select add trace from the list to add signals
from the available data field.



2. Creating Hierarchical Design

This chapter will show how to create a schematic, a symbol of the schematic, and a test bench of the
schematic.

2.1 Creating a schematic

Following the steps listed below, to create a schematic.

A. Open a schematic window as stated in section 1.2.

B. Click T on the schematic window to add instances. The Select Component Symbol form pops up
as Figure 4. It lists all the available symbols, including LTspice default symbols as well as the symbols
installed in section 1.1.

Ly Select Companent Symbol
Top Directory: | C:\Program Files (x86)\LTC\L Tspice/V\lib\sym v

Open this macromodel'’s test fodure

(%7 C:\Program Files (x86)\LTC\LTspice|V\ib‘\sym\.

a2 nmos pmos_018 tine
h nmos4 pmos_035 TVSdiod
ind nmos_018 pnp varactor
ind2 nmos_035 pnp2 voltage
LED npn pnp4 zEner
load npn2 polcap
load2 npn3 res
Ipnp npné res2
ttline pif schottky
mesfet pmos SOAtherm-NMOS
nif pmos4 sW

< >

Conce

Figure 4. Select component symbol form

C. Select pmos_018, click Ok on the Select Component Symbol form, and then click on the schematic
window to add pmos_018.
Repeat the procedure of step C to add nmos_018.

E. Press Escto stop adding component.

F. Click @ on the schematic window to add ports. The Net Name form appears as Figure 5.

ZHENG HUAN QUN 4



i Net Name

§'7 ) GND(global node 0)
\1/ C)coM
|

Fort Type: |None v

Cancel | oK
Figure 5. Net name form

G. Enter Vinin the ABC field, choose Input for the Port Type, and then click OK on the Net Name
form, and finally click the schematic window to add port Vin.
H. Repeat the procedure of step G to add the following ports.

Port Name Port Type
Vout Output

VDD Bi-Direct
GND Bi-Direct

%Kﬂlmz

" W=0.5u
1 L=0.18u
Vin) Vout -
— M1
7 W=0.5u
1 L=0.18u

<« GND -

Figure 6. Schematic window with instances

I. Right click the symbol if you need to change its size. A form with the symbol’s property pops up.
Change its Width to 1u as shown in Figure 7 and then click OK for the sample case. Keep AD, AS,
PD, and PS unchanged, now, and these will be configured later, in step H.

J.  Repeat the step above to change the width of pmos to 1u, too.

- ________________________________________________________________________________________________|
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i Monolithic MOSFET - M1

Model Name: | NM [ ok ]
Length(L): | 0.18 el
WidhWy: [u |

Drain Area(AD):
Source Area(AS):
Drain Perimeter(PD):
Source PermeterPS):
No. Parallel Devices(M):

'NM 1=0.18u w=Tu

Figure 7. NMOS property form

K. Hold Ctrl + right click a mos symbol (example: nmos symbol) to configure AS, AD, PS and PD to use
the sub circuit model included in the CMOS_018.lib . On the Component Attribute Editor form,
change NM to X on the row Prefix as Figure 8, and then click OK to finish it.

L7 Component Attribute Editor

Open Symbol: C:\Program Files (x86)\L TC\L Tspice/V\ib‘\sym\nmos_018 asy

This detemines the type of a circuit element. eg.. R, C.or L

Atribute Value Vis. ’*
| Prefix x_|
| InstName M1 X
| SpiceModel
| Value NM
| Value2 1=0.18u w=1u X w

== o]

Figure 8. Component attribute editor

-

Repeat the step above for the pmos symbol.
M. Click J on the schematic window to wire the components. The circuit will look like Figure 9 after

wiring. You can click i and then a symbol to move it, followed by click E™ orE 3 to rotate or

mirror it if necessary.

ZHENG HUAN QUN



3

R

=1u
L=0.18u

Vin

Figure 9. Schematic of inverter

N. Click File = Save As to save the schematic as inverter.asc.

2.2 Creating a symbol

The schematic has been created successfully. Next, it is to create a symbol for the schematic, so it can
be used in hierarchical designs like invoking an nmos symbol when patching the inverter schematic. To create
the symbol, following the steps stated below.

A. Open the schematic window with click & . Enter inverter.asc in the File name field for the sample
case.

B. Click File = New Symbol on the schematic window (inverter.asc window for the sample). A blank
symbol window appears.

C. Draw the symbol with lines, rectangles, circles, and etc from the pulldown menu — Draw as shown
in Figure 10.

ZHENG HUAN QUN 7



pa LTspice IV - [Untitled] -0
T+ Fle Edit Hierarchy | Draw View Tools Window Help [=]=]x]
|BF@pf e L EdERE BRI A8 SO
O Circle
" Arc
222 Line Style

A Tert T

inverterasc | T Untitle

R
G
A

Figure 10. Symbol creation window

D. The ports must be added as that of schematic (Figure 9 for the sample). Click Edit > Add Pin/Port.
The Pin/Port Properties form displays as Figure 11, enter Vin in the Label field, and then tick LEFT
under Pin Label Justification. Click OK and then the symbol window to add it.

L Pin/Port Properties

e | MO 5 31
Pin Label Justification

O
TOP

@LEFT  RIGHT()
BOTTOM [ ok ]
O

() NONE(Not Visible)

[ Vertical Text

o (512

Figure 11. Add Pin/Port properties form

E. Repeat step D to add the following ports. The symbol of the inverter schematic will be like Figure

12.
Port Name Pin Label Justification
Vout RIGHT
VDD TOP
GND BOTTOM

ZHENG HUAN QUN 8



Figure 12. Symbol of the inverter

F. Save the symbol after drawing with click File =>Save As... . The name given must be as same as the
name of the schematic and also it must be saved in the same directory as that of the schematic.

For the sample case, it is saved as inverter.asy. Note that the extension of the symbol is .asy while
the schematic is .asc.

Now, the symbol has been created and it is ready to be used for other designs.

2.3 Setup a test bench

A test bench is used to simulate a design (schematic) and check if it meets its design specifications. To
setup a test bench, in fact, the processes are as same as creating a schematic described in section 2.1. Follow
the steps listed below to setup the test bench of the inverter.

A. Click E to open a new schematic window.

B. Click T to add the self-created symbol (sample: inverter). Enter the path where you saved the
symbol (inverter) in Top Directory field, choose the symbol, and then click OK as Figure 13.

ol Select Component Symbol
Top Directory: | H:\EE4415-L Tspice v
D
& i
> > pen U
G D inverter
1] HAEE4415-LTspice
veter
Cancel L 0K

Figure 13. Add self-created symbol

C. Click T toadd LTspice symbols: one cap and two voltage as shown in Figure 14.

ZHENG HUAN QUN



L7 Select Component Symbol o Select Component Symbol
Top Directory: | C:\Program Files (x86)\LTC\L TspicelV\ib\sym v | Top Directory: | C:\Program Fies (86)\LTC\L TspiceV\ib\sym v |
; Voltage Source, either DC, AC,
ra PULSE, SINE, PWL, EXP, or

SFFM

Open this macromodel's test fidure

. Open this macromodel'’s test fodure
l {cap |

voltage

%3 C:\Program Files (x86)\LTC\L TspicelVNib\sym", (%) C:\Program Files (xB86)\LTC\L TspicelV\lib\sym\,
[PowerProducts] [y E— prpd sw
[References] csw FenteBead polcap thine
[SpecialFunctions] curent FemteBead2 res TVSdiode
bi diode 9 res2 varactor
bi2 e g2 schottky
bv e2 h SOAthemm-NMOS zener
< > < >
1 [ f
Cancel | ok ] [ cance

Figure 14. Add the symbols of cap and voltage

Click < on the schematic window to add ground.

D.
E. Click ®to add port Vout with the Port Type as Output.
F. Click /. to connect the symbols as Figure 16.
G. Edit the properties of the components: V1 (DC source), V2 (Pulse), and C1 (capacitor) with right
click each of them, referring to Figure 15.
L Voltage Source - V1
DCvalueVl: [2.0
| Cancel |
Series Resistance[0)]: | 1
| Advanced |
Feg Independent Voltage Source - V2 n
Functions DC Value
O (pone) DC value: [20

(@ PULSE(V1 V2 Tdelay Trise Tiall Ton Period Neycles)
() SINE{Voffset Vamp Freq Td Theta Phi Neycles)
(CEXP(V1V2 Td1 Taul Td2 Tau2)

Make this information visible on schematic: |+

Small signal AC analysis({.AC)

() SFFM(Voff Vamp Fcar MDI Fsig) AC Amplitude: | ‘
OPWLETvI12v2.) ACPhase:| |
() PWL FILE: — Make this information visible on schematic:
Parasttic Properties
VinitiallV]: [0 Series Resistance[Q]: :
VonVE: |20 Parallel Capacitance(Fl: | |
Tdelayls]: |0 Make this information visible on schematic:
Trise[s): -ln
Thallis): | 1n
Ton[s]: AL -
Toeriods]: [10r]
Neycles:

Additional PWL Points

Make this information visible on schematic:

ZHENG HUAN QUN

10



Von

Vinitial
Tdelay | Trise Ton _ Tfall
T
Tperiod N
LT Capacitor - C1 n
Manufacturer.  ——
e = [ox |
B
- Capacitor Properties
CapactancelF]
Votog R
RMS Curert RatinglAl: ||
Equiv. Sefes InductancelH}: | |
Equiv Paralll Resistanceln) |
Equv. Paralel CapacitancelFl. | |

Figure 15. Edit properties of the components

H. Save the schematic.

Figure 16. Test bench of the inverter

The test bench has been created as Figure 16.

ZHENG HUAN QUN 11



3. DC Analysis

This chapter shows how to run DC analysis with the sample - inverter test bench, following the steps
listed below.

A. Click @ to open the test bench which is created in section 2.3.

B. To add wire names for viewing the results after simulation, click (& t5 add VDD and Vin with Port
Type — none, one by one with click the respective wires as Figure 17 shows.

VDD <o ner

10f
PULSE(0 2,0 0 1n 1n 4n 10n)

Figure 17. The test bench with wire names

C. Click = to save the schematic.
Click Simulate - Edit Simulation Cmd.

E. Select the DC sweep tab on the Edit Simulation Command form, enter the fields under the 1
Source as Figure 18, click OK on the form, and then click the schematic window to put the
command on the window.

L Edit Simulation Command “

Transient | AC Analysis DCsweep | Noise | DC Transfer | DC op pnt

Compute the DC operating point of a circuit while stepping independent sources and
treating capacitances as open circuits and inductances as short circuits.

1st Source | 2nd Source | 3rd Source
Name of 1st Source to Sweep: V2
Type of Sweep: Linear v
Start Value: 0
Stop Value: 2.0

Increment: 0.01

Syntax: .dc [<oct.dec lin>] <Source1> <Start> <Stop> [<incr>] [<source2> ..]
deV20200.01

==

Figure 18. Edit simulation command

ZHENG HUAN QUN 12



Note: Figure 18 shows that it will do DC analysis with sweep V2 from OV to 2.0V in a step size of 0.01
volts.

F. Click °P to add SPICE directive. Enter .lib CMOS_018.lib in the blank field as shown in Figure 19,
click OK and then click on the schematic window to add it.

i Edit Text on the Schematic:
How to netlist this text Justification Font Size 0K
Cw _ Left v 1.5(default) W Cancel
®) SPICE directive [ Verical Text

Jib CMOS_018 ib|

Type Ctrd-M to start a new line.

Figure 19. Add SPICE directive

Note: CMOS_018.lib is the user defined model library. Without adding it, the simulation cannot
start.

G. Click # to start DC simulation. An empty waveform window appears automatically after the
simulation is successfully finished. If there is problem with the simulation, you can get error
information from View = SPICE Error Log.

H. Move your mouse over to the schematic window, and then click the wires labeled with Vin and
Vout. The waveforms of Vin and Vout display on the waveform viewer as shown in Figure 20.

ZHENG HUAN QUN 13



Ly LTspice IV - test_bench.asc = =

File Edit Hierarchy View Simulate Tools Window Help

ZN—A = Rl QOQRIRIIHAR i 2OMA S8 B3O

4 test benchasc |} test_benchraw

o] test_bench.raw o || @

I I T T T
D.2v 0.4v 0.6V 0.8V 1.0v

X test_bench.asc =R~
b CMOS_018.5ib ~
VoD
vi
20
ct
101
PULSE(0 2.0 0 1n 1n 4n 10n)
AcV202.00.01 ~
v

Figure 20. Waveforms and the test bench

I.  Right click your mouse on the waveform window, choose Add Trace to check other signals of the
test bench.

Now, DC simulation is finished. Next Chapter, we will see how to do transient simulation.

4. Transient Analysis

This chapter descripts how to run a transient analysis with LTspice. Following the steps listed below,
using the sample circuit — test bench, go through the procedures of transient analysis.

A. Click @ to open the test bench which you used in section 3.

B. Click Simulate = Edit Simulation Cmd to bring up the Edit Simulation Command form.

C. Click the Transient tab on the form, and then enter 40n in the field of Stop Time and 0.1n in the
field of Time to Start Saving Data, leaving others unchanged.

D. Click OK on the form and then click the schematic window to insert the command. The Edit
Simulation Command and the schematic are shown in Figure 21.

ZHENG HUAN QUN 14



i Edit Simulation Command

5 test_bench.asc o |[=
Trensient | AC Analysis | DC sweep | Noise | DC Transfer | DC op prit
lib CMOS_018.Iib Pesform a nondinear, time-domain simulation
VDD Stop Time:  40n
Time to Start Saving Data: |0.1n
Vi Maxdimum Timestep
<> Start extemnal DC supply voltages at OV: | |
— 20 Stop simulating f steady state is detected: [ |
Step the load cument source
10f Skip Initial operating poirt solution
PULSE(O 2001n1n 4 10“) Syntax: tran <Tprint> <Tstop> [<Tstart> [<Tmaxstep>]] [<option> [<option>] ...]
;dc V20 2.0 0.01 :”7 tran 0 40n 0.1n
.tran 0 40n 0.1n
Cancel 0K

Figure 21. Command for transient simulation

Note: the semicolon in front of dc means the DC simulation is disabled.

E. Click * to start transient simulation. If there is any problem with the simulation, you can get
error information from View ->SPICE Error Log.

F. Move your mouse over to the schematic window, and then click the wires labeled with Vin and
Vout. The waveforms of Vin and Vout display on the waveform viewer as shown in Figure 22.

 oed test_bench.raw =N ]

Vlvout]

T T
12ns 16ns

'[: test_bench.asc = C1 &3
dib CMOS_018.lib A
VDD
<>\I1
1720
10f
PULSE(0 2.0 0 1n 1n 4r 10n)
:de V2 0 2.0 0.01 %7
Aran 0 40n 0.1n v

Figure 22. Waveforms of transient analysis for the test bench

Transient analysis is finished, up to now. Next, we will look into the waveforms of the transient simulation,
to get the delay, rise time and fall time as well as the power consumption from the waveform viewer.



5. Delay Simulation

This chapter depicts how to find the delay of a circuit from the waveforms, and shows what .MEAS
commands should be used to get the delay, with the same sample circuit — inverter.

5.1 Capture from waveforms
Follow the steps listed below to get the delay from waveformes.

A. Click Vout and Vin to get the waveforms of the inverter after transient simulation.

Click the waveform window to activate it.

C. Click Plot Setting = Add Trace, enter 1 which equals to 50% x Vin (or 50% x Vout for this case) in the
field of Expressions(s) to add of the Add Traces to Plot form, and then click OK on the form, as figure
23. A horizontal line with the value of 1V is added on the waveform window as shown in Figure 24.

@

L7 Add Traces to Plot

Only list traces matching
OK

Available data || Astensics match colons Cancel
Vivdd)
Vivin)
Vivout)

IC1)

(V1)

(V2

time
bx{x1:VOD)
befe1:VIN)
befe1:VOUT)

Expression(s) to add:
1

[#] AutoRange
Figure 23. Add traces to plot window

& test_inverter_Delay.raw e || o )
Vivin

1.0012

+1.0010

+1.0008

+1.0006

e

Figure 24. Waveforms of the inverter

ZHENG HUAN QUN



D. Click & , and then draw a rectangle over the last cycle of the waveforms with holding the left button
of the mouse to enlarge the area. Now, it looks like Figure 25. It could be zoomed in further if necessary,
for viewing the tpn. and tyn clearly.

4 test_inverter_Delay.raw
1.0012
1.0010
]
+1.0006

1.0004

t-1.0002

1.0000
+0.9998
0.9996
+0.9994
-0.9992
- 0.9990

H T +0.9988
10.8ns 12.2ns 32 ] 35.7ns 3 37.1ns

Figure 25. Waveforms after zoomed in

E. Right click V(vout) label on the waveform window to add 1% and 2" cursors as Figure 26.
o Expression Editor - F(V(vout),...) ﬂ
Trace Color El v Attached Cursor: | [EXED v 0K
Enter an algebraic expression to plot: Cancel

Vivout)

Delete this Trace
Figure 26. Add cursors

1.00010

—1.00008

Fo test_inverter_Delay.raw n ~1.00006

Cursor 1

V{VDU‘U +1.00004

Horz: | 30.424486ns Vett: [396 77227mV [-1.00002
Cursor 2

V(vin) - +—1.00000
Horz: | 30.39982%ns Vert: [955‘ 65753mV

s qQOQqqH
Diff {Cursor2 - CLIISDI']:__ 0.99998

Horz: | 5 Vert: [2 8852614mV I 0.99998
Freq: |40.555556GHz Slope: |'1 17013e+008

(-0.99994
(-0.99992

- 0.99990
30.8ns 31.0ns 31.2ns

Figure 27. Find tpn. from the graph

ZHENG HUAN QUN 17



F. Move the cursors and zoomed in further to find the tpn. It is equal to 24.657534ps as Figure 27 shows,
which should equal to the absolute value of Diff (Cursor2 — Cursor1).
G. Repeat step F to find tywm. It is 209.0268ps as Figure 28.

—1.00017
+1.00014

o test_inverter_Delay.raw 1.00011

Cursor 1 +1.00008
V{vout)

; : Horz [35 610578ns Vert
1.021 g : Cursor 2

0.99v- Yorsd

Horz: [35.401551ns Ver: [936 89704mV
Diff (Cursor2 - Cursor1) .
Horz: [-209.026%0s Vert: [-3.4572611mV t-0.99993

Freq: [4.7840756GHz  Slope: [1.65398e+007

0.90V— +0.99990

0.87V- --e o\ -0.99987

0.84v-] I : l-0.99984

0.81V " ; ; i r | I | f i i
35.0ns 35.1ns 35.2ns 35.3ns 35.4ns 35.5ns 35.6ns 35.7ns 35.8ns 35.9ns 36.0ns 36.1ns 36.2ns 36.:

Figure 28. Find tpin from the graph

Now, the delay can be calculated with tgelay = 0.5 X (tphi + torn) = 116.842167ps. The value of the delay
may not be accurate because it depends on the positions of the cursors being put.

5.2 Using .MEAS

. Click @ to open the test bench
B. Click °P to add SPICE directive, and enter the .MEAS commands in the blank field as Figure 29.

L Edit Text on the Schematic: “
How to netlist this text Justification Font Size 0K
Comment Left v 15(defaut) v
= o - Cancel
®) SPICE directive || Vertical Textt

.MEAS TRAN TpLH

+TRIG V(Vin) VAL=0.5"V{VDD) TD=32n FALL=1
+TARG V(Vout) VAL=0.5"V(VDD) TD=32n RISE=1
.MEAS TRAN TpHL

+TRIG V(Vout) VAL=0.5"V(VDD) TD=28n FALL=1
+TARG V({Vin) VAL=0.5"V{VDD) TD=28n RISE=1

Type Cid-M to start a new line.

Figure 29. Commands for measuring the delay
Note: TD=32n FALL=1 (or RISE=1) means the first fall edge (or rise edge) after 32ns.

C. Click OK on the Edit Text on the Schematic form, and then click the schematic window to insert it. The
schematic looks like Figure 30, now.

ZHENG HUAN QUN 18



Figure 30. Test bench with the .MEAS commands for measuring delay

D. Click # to run the transient simulation.
E. When the simulation stops, Click View = SPICE Error Log. The SPICE Error Log window pops up as
Figure 31. The tpLH and tpHL are shown and highlighted with the red rectangle in Figure 31.

i SPICE Error Log: H:\EE4415-LTspice\test_inverter_Delay.log

*:.i.rr.:uit : * H:\EE4415-LTspice\test_inverter_ Delay.asc ~

Direct Newton iteration for .op point succeeded.
Ignoring empty pin current: Ix(xl:gnd)
Ignoring empty pin current: Ix(xl:gnd)

tplh=2.1054e-010 FROM 3.54e-008 TO 3.56105e-008
tphl=-2.41424e-011 FROM 3.04241e-008 TO 3.04e-008

Date: Tue Nov 15 14:18:55 2016
Total elapsed time: 0.218 seconds.

tnom = 27

temp = 27

|method = modified trap
totiter = 2436
traniter = 2429
tranpoints = 1134
accept = 1110

rejected = 24

|matrix size = 5
fillins = 0

solver = Normal
Ftrlx Compilerl: 132 bytes object code size 0.1/0.1/[0.1]

trix Compiler2: 28 opcodes 0.1/[0.1]/0.1

Figure 31. SPICE log with the delay information

ZHENG HUAN QUN
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The delay, tgelay = 0.5 X (tpue + ton) = 117.3412ps, which is more accurate. The values with both the
methods are approximately same.

6. Rise Time and Fall Time

This chapter describes how to get the rise time and fall time of a circuit. As in chapter 5, both methods —
capture from waveforms and using .MEAS command are discussed with the same test bench.

6.1 Capture from waveforms

A. After the transient analysis, click the wire labeled with Vin and Vout on the schematic window.

Click Plot Setting = Add Trace, add 0.2V which equals to 10% x Vout and then click OK.

C. Click Plot Setting 2> Add Trace, add 1.8V which equals to 90% x Vout and then click OK. Now the
waveform window looks like Figure 32.

w

ot test_inverter RiseFallTime.raw = o ™

Figure 32. Waveforms with 10% x Vout and 90% x Vout

D. Right click the V(vout) label on the waveform window to add the cursors as Figure 26.
E. Move the cursors to the rising edge of the Vout to find the rise time as Figure 33. The rise time equals
to 218.51852ps which is the absolute value of the Diff (Cursor2-Cursorl)
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o test_inverter_RiseTime.raw o || =]

i test_inverter_RiseTime.raw -

Cursor 1 =
Vivout)

Horz: [EE Ver: [1.7862107V
Cursor 2

Vivout)
Horz: | 35.48388%ns Vert: [209.19831mV
Diff (Cursor2 - Cursor1)
Horz: [218518520s || Ve: [-15770124V

Freq: |4.5762712GHz Slope: |7.21684e+009

33.6ns 34.0ns

T T T
35.6ns 36.0ns 36.4ns 36.8ns 37.2ns 37.6ns 38.0ns

Figure 33. Capture the rise time from graph

F. Then, move the courses to the falling edge of Vout to find the fall time as Figure 34. The fall time
equals to 198ps.

™ test_inverter_FallTime.raw [o] B =]

V(vin)

i test_inverter_FallTime.raw

Cursor 1 -
Vivout)

Horz: [30.3ns Vert: [1.8021217V

Cursor 2

Vivout)
Horz: | 30.498ns Vert: [201.21666mV
Diff {Cursor2 - Cursor1)
Horz: | 198ps Vert: |-1

Freq: [5.0505051GHz  Slope: [-8

T T ‘_‘—77]77]—% =
27.0ns 27/.6ns 28.2ns 28.6ns 29.4ns 30.0ns 30.6ns 31.Z2ns 31.8ns 32.4ns 33.0ns 33.6ns 34.2ns

Figure 34. Capture the fall time from graph

6.2 Using .MEAS

To find the rise time and the fall time, simply repeat the steps listed in section 5.2 but replace the .MEAS

commands with those shown in Figure 35. The rise time and fall time are equal to 225.269ps and 197.423ps
respectively, referring to Figure 36.
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Figure 35. The test bench with the .MEAS commands for getting the rise time and fall time.

Fo SPICE Error Log: H\EE4415-LTspice\test_inverter_RiseFallTime.log
Circuit: * H:\EE4415-LTspice\test_inverter_ RiseFallTime.asc A~
Direct Newton iteration for .op point succeeded.
Ignoring empty pin current: Ix(xl:gnd)
Ignoring empty pin current: IX(xl:gnd)
tr=2.25269e-010 FROM 3.54853e-008 TO 3.57106e-008
£f=1.97423e-010 FROM 3.03007e-008 TO 3.04982e-008
|Date: Wed Nov 02 15:03:53 2016
Total elapsed time: 0.151 seconds.
tnom = 27
temp = 27
|method = modified trap
totiter = 2436
traniter = 2429
tranpoints = 1134
accept = 1110
rejected = 24
|matrix size = 5
fillins = 0
solver = Normal
trix Compilerl: 8 opcodes 0.1/[0.1]/0.1
trix Compiler2: 335 bytes object code size 0.1/0.1/[0.1]
v

Figure 36. SPICE Log for viewing the rise time and fall time.
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7. Power Consumption Simulation

This chapter shows how to get the power consumption with the two methods used in the previous
chapters.

7.1 Static power

Following the steps below to find out the static power consumption.
A. Open the test bench circuit.
B. Connect V2 to ground, and add .MEAS commands as Figure 37.

Jib CMOS_018.lib

VDD
.MEAS TRAN | AVG -(V1)
.MEAS TRAN Pstat AVG -I(V1)*V(VDD)
V1 VBD o
C) £ 3 = Vout >
D>
T 2.0 e
T10f
L] L
N

.tran 0 40n 0.1n

Figure 37. Test bench for static power consumption

C. Run the test bench with click * .
. Add trace -I(V1)*V(vdd) on the waveform window with click Plot Settings = Add trace.
E. Hold the Ctrl key + press left mouse button over the waveform label of -I(V1)*V(vdd). A small table
with the average power consumption pops up. The reading is 21.605pW.

e test_inverter_StaticPower.raw = l=]
AV1)*Vivdd)

g {7 Waveform: -I{V1)*V(vdd) B

Interval Start: | Os

Interval End: | 39.9ns

21.6062pW-{ =
~

Integral: | 0.00086204f)

2.0000V

1.9996V—

"_ilil!]:_'\‘f..

1.9988Y

1.9984v- -10.8038pA

1.9980V—+ t t T t+ 1 -10.8040pA
Ons 4ns 8ns 2ns 24ns 1Z2ns }bns

Figure 38. Capture the static power from waveforms



F. Open the SPICE Error Log window, the average power (pstat) also can be found, which is 2.1605e-011

Fo SPICE Error Log: H:\EE4415-L Tspice\test_inverter_StaticPower.log

Circuit: * H:\EE4415-LTspice\test_inverter_ StaticPower.asc A

Direct Newton iteration for .op point succeeded.

Ignoring empty pin current: Ix(xl:gnd)
Ignoring empty pin current: Ix(xl:gnd)

i: AVG(-i(vl))=1.08025e-011 FROM 0 TO 3.09e-008

pstat: AVG(-i(vl)*v(vdd))=2.1605e-011 FROM 0 TO 3.99e-008

Date: Thu Nov 03 13:39:21 2016
Total elapsed time: 0.126 seconds.

tnom = 27

temp = 27

|method = modified trap
totiter = 2095
traniter = 2088
tranpoints = 1045
accept = 1045

rejected = 0

Imatrix size = 3

fillins = 0
solver = Normal

trix Compilerl: 3 opcodes 0.1/[0.1]1/0.1
ﬁtrix Compiler2: 15 opcodes 0.1/[0.1]/0.1

Figure 39. Static power consumption with .MEAS

7.2 Dynamic power

The method to find the average dynamic power is as same as that to find the average static
power, except that V2 is connected back to the pulse as Figure 40.

Figure 40. Test bench for the dynamic power consumption
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After simulation, view the SPICE Error Log to find the average power consumption as Figure 41. It

also can be found from the waveform viewer as Figure 42.

ro SPICE Error Log: H:\EE4415-LTspice\test_inverter DynamicPower.log

Circuit: * H: .-.EE-I-I-D*._-SF‘_CE «.:ea:_;n*fe::e:_i:;r.a.r:‘.c?r:we: .asc ~

Direct Newton iteration for .op point succeeded.
Ignoring empty pin current: Ix(xl:gnd)
Ignoring empty pin current: Ix(xl:gnd)

i: AVG(-i{vl))=6.175e-006 FROM 0 TO 3.
pdyn: AVG(-i(vl)*v(vdd))=1.235e-005 ER

am aa L an
f 1ll:34:

35 2016
Total elapsed time: 0.140 seconds.

tnom = 27

temp = 27

method = modified trap
totiter = 2436
traniter = 2429
tranpoints = 1134
accept = 1110

rejected = 24

matrix size = 5

fillins = 0
solver = Normal

Matrix Compilerl: 132 bytes object code size 0.1/0.2/[0.1
Matrix Compiler2: 335 bytes object code size 0.1/0.1/[0.1

Figure 41. Dynamic power consumption with .MEAS

= test_inverter_DynamicPower.raw o | 3| =

300mW dj*1000

300mW— -
AT Waveform: -I(V1 )*V{vdd)...

270mYW

Interval Start: | Os|

Interval End: | 39.9ns

Average:  12.35mW

Integral: | 492 77pJ

240mW—
210mW—
1 80mW—

W

120mWYY— i!

90mW|
60mYW— |
I0mW—H |
UmW—IE-: ST [ N

I0mW—

T I I
Ons 4ns gns

Figure 42. Capture the dynamic power from waveforms
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8. Conclusion

The manual describes how to run DC and transient simulations with LTspice. It also elaborates how to find
the delay, rise time, fall time, and average static power consumption as well as the average dynamic power
consumption. Two methods are used in the elaboration, capture from waveforms and using spice measure
command.

Thanks for using the manual. You are welcome to feedback.

- ________________________________________________________________________________________________|
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